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Getting Started Tutorials 
 

 An Overview of WINKS SDA 
 Installation 
 Tutorial 1 – Analyzing Summary Data 
 Tutorial 2 – Entering Data to Analyze 
 Tutorial 3 – Using Data from an Existing File 
 Tutorial 4 – Using SDA Graphs 
 Tutorial 5 – Importing data from Excel 

 
SDA Tip – Do the tutorials first – it makes running SDA quicker and easier. 
 Name Change? – If you’ve used WINKS before, you’ll notice that we now refer to 

the program as WINKS SDA or just SDA – since Microsoft also has a program called 
WINKS, we think it will make it easier to refer to WINKS as SDA, which stands for 
Statistical Data Analysis. 

 Reference -When you report SDA results in a professional publication, use the 
following citation: TexaSoft, WINKS SDA Software, Sixth Edition, Cedar Hill, 
Texas, 2007. 
 

An Overview of SDA 
Statistical data analysis allows you to make informed decisions. WINKS SDA is a 
statistical data analysis program designed by professional statistical consultants and 
researchers that allows you to calculate commonly used statistical data analysis 
procedures and graphs. A few of the main benefits of SDA include: 
1. The native file format for WINKS SDA is an “.sda” file. SDA can also read .DBF, 

Excel and text files (delimited). Older WINKS files that are in the .DBF format 
may be opened in SDA and saved into the new .SDA file format. 

2. Many SDA procedures report information that allows you to make a reasonable 
conclusion based on the statistical findings -- unlike other statistical programs that 
make you run each part of an analysis separately and piece your answers together. For 
example, in SDA’s Analysis of Variance procedures, multiple comparisons are 
automatically performed and boxplots are created to show you where specific pair-
wise differences lie (unlike most other statistical programs.) 

3. SDA often provides warnings when common assumptions are not met and makes 
suggestions about how a particular outcome could be interpreted. For many tests, an 
explicit hypothesis is stated to help you understand the exact intention of the analysis.  
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Installation  
Place the WINKS SDA distribution CD in your CD Drive. This should automatically 
start the SDA Installation procedure. If the installation does not automatically begin: 
Click START/Run and enter D:\SETUP.EXE (Use your CD drive name.) Or, to make 
sure you have the latest release, you can download the installation program at  

http://www.texasoft.com/updates 
 
Follow the installation instructions on the screen. When you begin SDA for the first time, 
a dialog box will appear, asking for a key code. Enter the code provided with your CD. 
(Some vendors provide the code as a “Serial Number.”) After the installation you will be 
prompted to choose program options. Select options you want to change, or leave the 
default options in place (recommended) and choose Ok. You can change these options at 
any time by choosing "Change Setup Options" from the Help menu.  

The Analysis Process 
Here is a brief look at the data analysis process: 
 

Enter data or read data from an existing file. 
 

Select an analysis from the Analyze menu. 
 

Examine the output. 
 

Tutorial 1 – Analyzing Summary Data 
Suppose you have the following (summarized) information about two groups you wish to 
compare: 

Data for Group 1  
Mean = 23.44, Standard Deviation = 3.41, N = 8 

Data for Group 2 
Mean = 31.97, Standard Deviation = 3.22, N = 9 

To perform an Independent Group Student’s t-test from summarized data, follow these 
steps: 
Step 1: Begin SDA. Select Analyze/t-tests and ANOVA/ Ind. Group from Summary 
Data.  
Step 2: When prompted to enter the number of groups, enter 2. This dialog box appears:  
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Step 3: Enter the numbers as shown in the dialog box and Click Ok. The following 
output appears.  
 
 -------------------------------------------------------------------------- 
 Independent Group Analysis                                    Summary Data 
 -------------------------------------------------------------------------- 

 Group Means and Standard Deviations 

 Grp 1: mean = 23.44            s.d. = 3.41              n =  8  

 Grp 2: mean = 31.97            s.d. = 3.22              n =  9  

 
 Independent group t-test on Summary Data 
 -------------------------------------------------------------------------- 

 Test equality of variance: F = 1.12 with (7, 8) D.F.  p = 0.866 (two-tail)  

 
 Note: Since the p-value for equality of variance is greater than 0.05, 
 use the Equal variance t-test results. 

 

(continues…) 

 

 Independent Group t-test Hypotheses: 
 ------------------------------------ 

 Ho: There is no difference between means. 

 Ha: The means are different. 

 

   Equal variance: Calculated t= -5.3 with  15  D.F.  p <= 0.001 (two-tail) 

 Unequal variance: Calculated t= -5.28 with 14.5 D.F. p <= 0.001 (two-tail) 

 

The “test for equal variance” indicates which version of the t-test to use. Since this test is 
non-significant (p=0.866) you should use the “Equal Variances t-test” (unless you have 
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some other reason to use the more conservative Unequal variances test.) Either way, your 
conclusion is to reject the null hypothesis (Ho) since p <.001 which show evidence for 
the alternative that the means are different. 

Other Summarized Data Analyses  
Some of the other analyses in SDA that you can run from summary data include: 

 Independent Group Means Comparison – Tests and Analysis of Variance 
 Single Sample t-test 
 Dunnett’s Test 
 Contingency Table – Chi-Square Analysis -- also including Yate’s Test, Fisher’s 

Exact Test, Relative Risk, Odds Ratio, Sensitivity and Specificity, and more. 
 Goodness-of-Fit Analysis 
 Test of a Difference between Two Proportions 
 P-value determination 
 Bar and Pie Charts 
 Kappa – Interrater reliability (Professional Edition) 

 

Tutorial 2 – Entering Data to Analyze – Comparing 
Means 

This example shows how to enter “raw” data into SDA and use that information to 
perform an analysis and display a graph. Suppose you are testing the effectiveness of four 
kinds of hog feed. You randomly assign 15 hogs to 4 groups, feed each group one of the 
feeds for a month, and observe weight gain. You want to know which type of feed 
produced the most (average) weight gain for the four groups.  

GROUP(Feed)   OBS(WEIGHT) 
1    60.8 
1    67.0 
1    54.6 
1    61.7 
2    78.7 
2    77.7 
2    76.3 
2    79.8 
3    92.6 
3    84.1 
3    90.5 
4    86.9 
4    82.2 
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4    83.7 
4    90.3  

To perform this analysis: 

1. Enter the data into a SDA database 
2. Select the type of analysis to perform 
3. Observe and interpret the output 

Step 1: When you begin SDA a blank data grid appears as shown below: 

 

You could immediately enter data, but we recommend that you follow this procedure: 

Step 2: Click on the Attributes tab at the bottom of the SDA grid to display the following 
screen:  
 

 
 
Define your data set variables in this grid. For this case you need a grouping variable 
(FEED) and an observation variable (WEIGHT).  
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 In the Name column enter FEED in row 1 and WEIGHT in row 2 
 In the Type column select (N) Number for both variables. 
 In the Decimals column enter 0 for Feed and 1 for Weight 
 In the Width column enter 1 for Feed and 5 for Weight 
 Leave the Missing column blank for now. 
 See the completed information below: 

 

 

Step 3: Click on the Data tab to return to the data grid. Enter the data from the data list 
above as shown below: 

 

Notice that for this example 1, 2, 3, and 4 represent Feed brands – you could use A, B, C, 
D or any alpha-numeric name for the group names. The Weight field contains the variable 
you observed. In this case it is weight gain.  

Step 4: When you have finished entering the data, select File/Save As and save the data 
set with the name Hog Tutorial. (You don’t have to save the file to do an analysis, but we 
recommend it.) 

Step 5:  Select Analyze/t-test and ANOVA/ Independent Group (t-test/ANOVA).  
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Step 6: Choose what fields to use. A dialog box appears allowing you to select which 
fields to use for this analysis. Select the FEED field, and click on the Group button. 
Then select the WEIGHT field and click on the Add button. Your field choices will look 
like the dialog box in the figure below. Click Ok to continue.  

 

Step 7: The output compares the 4 means and shows that feed types 3 and 4 produce a 
significant higher weight gain than do feeds 1 and 2. (Comparisons with an “*” in the 
“Newman-Keuls” table indicate significant differences.) 

Grouping variable is GROUP 
 Analysis variable is OBS 
 
 Group Means and Standard Deviations 
 ----------------------------------- 
   1: mean = 61.025               s.d. = 5.0822            n =  4  
   2: mean = 78.125               s.d. = 1.4886            n =  4  
   3: mean = 89.0667              s.d. = 4.4276            n =  3  
   4: mean = 85.775               s.d. = 3.5976            n =  4  
 
Analysis of Variance Table 
 
 Source              S.S.        DF             MS      F         Appx P 
 --------------------------------------------------------------------------- 
 Total            1923.41        14 
   Treatment      1761.24         3         587.08   39.82          <.001 
   Error           162.17        11          14.74 
 
   Error term used for comparisons = 14.74 with 11 d.f. 
                                                                  Critical q 
 Newman-Keuls Multiple Comp.        Difference   P     Q          (.05) 
 ------------------------------------------------------------------------ 
       Mean(3)-Mean(1) =                28.0417   4    13.523       4.256 * 
       Mean(3)-Mean(2) =                10.9417   3     5.277        3.82 * 
       Mean(3)-Mean(4) =                 3.2917   2     1.587       3.113 
       Mean(4)-Mean(1) =                  24.75   3    12.892        3.82 * 
       Mean(4)-Mean(2) =                   7.65   2     3.985       3.113 * 
       Mean(2)-Mean(1) =                   17.1   2     8.907       3.113 * 
 
   Homogeneous Populations, groups ranked  
 
                  Gp Gp Gp Gp 
                   1  2  4  3 
                        ------ 
                  ---          
                     ---       
This is a graphical representation of the Newman-Keuls multiple comparisons 
test. At the 0.05 significance level, the means of any two groups 
underscored by the same line are not significantly different. 
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(Tukey or Sheffé comparisons might appear instead, depending on which options you’ve 
selected in the program setup. Help/Change Setup Options.) 

Step 8: To display a graphical interpretation of the analysis, select Graphs/Display 
Graph. The default graph shows a box and whiskers plot comparison in the following 
graph:  

 

Step 9: From the group comparison plot, you can select a variety of display options. 
Select Edit/Options to display the options menu for the graph.  

Step 10: For this example, check the following options (and uncheck all other options) 
on Graph Options dialog box:  

 Display Means  
 Error Bar (+/- St. Error of the Mean)  
 Connect Means  
 Bar Graph of Means  

The following graph is displayed. Print the graph by selecting File/Print or copy the file 
to the Windows clipboard by selecting Edit/Copy to Clipboard. 
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Tutorial 3 – Using Existing Data 

This example shows you how to open an existing data set, display descriptive statistics on 
a single variable, and display a histogram. Follow these steps:  

Step 1: Select the file named EXAMPLE.SDA. Once the file opens you will see the 
data in the data grid. 

Step 2: To perform a Descriptive Statistics analysis on this data select Analyze, 
Descriptives, Detail/One Variable. A dialog box appears where you can choose a field 
name. First click on the checkbox labeled “include stem and leaf plot?” Click on 
AGE, and Ok, as shown in the following dialog box. 
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Step 3: A dialog box is displayed allowing you to specify options for the Stem and Leaf 
plot. Click on the checkbox labeled “Split stem leaf value in half.” Click Ok. 

Step 4: The output contains descriptive statistics from the data in the AGE field. Scroll 
this window to view all of the output. 
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Note: The “Tukey” output will differ slightly if the “Display outliers” option was selected in the Setup 
options (Help/Change Setup Options.) 

Step 4: To display a graph of the data select Graph/Display Graph.  A screen appears 
showing a histogram of the AGE data. Select Edit/Display Normal Curve to add a bell 
curve (normal curve) to the graph.  The graph is shown below: 
 
 

 

Step 5: To combine the graphic and text output, first select Edit/Copy to clipboard 
while viewing the graph. Then select File/Exit to return to the text output. Place your 
cursor at the end of the output and select Edit/Paste. The graph is pasted at the end of the 
output file. Size the graph by clicking on it. Sizing buttons appear at each corner. Click 
and drag on one of the sizing buttons to make the graph smaller.  

Step 6: You can now print the output including the graph, or select Edit/Select all and 
Edit/Copy then paste the output into a word processor. 
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Tutorial 4 – Using SDA GRAPHS 

SDA includes two types of graphs: 

• Analytic graphs – are designed to help you understand the results of statistical 
tests.  

• Excel graphs –displayed in Microsoft Excel (you must have Excel installed on 
your computer for this option to work.) (You can edit the resulting graph in 
Excel.) 

Graph Example 1: This Analytic graph allows you to examine the relationship between 
several pairs of variables at once.  

Step 1: Open the data set named EXAMPLE.SDA.  

Step 2: Select Graphs/Charts and Correlation Matrix Scatterplots from the menu.   

Step 3: From the variable selection dialog box, select the variables TIME1 to TIME4 as 
shown below by highlighting the variables names and click Add. 

 

Step 4: Click Ok and the matrix of graphs will be created, as shown below. 

Step 5: Select Edit/Display Regression Lines to display regression lines on each graph.  
This graph allows you to examine the relationships of several variables at once to 
discover which may be highly correlated and which are not. 
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Graph Example 2: The Dynamic graph example shows how to create a bar chart in 
Excel. 

Step 1: Open the data set BARCHART.SDA (File/Open dataset)  

Step 2: Select Graphs/Bar Chart (Requires Excel).  (Be sure to select the Excel version 
of the Bar Chart.) If you do not have Excel loaded on your computer, or if it is an 
incompatible version of Excel, you will get an error message when you attempt to create 
an Excel chart. 

Step 3: Click on VAR1 in the field box and Add. Click on LABEL variable name in the 
Field box and click on the Label button. Click Ok. The Excel program opens and within 
the worksheet a bar chart is displayed as shown below. 

VAR1
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Step 4: Right click on graph and Select Chart Type. Select the 3-D chart (middle left 
option) to display the graph in a 3D format as shown below:  
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Experiment with other options in Excel, but keep in mind that you can easily distort the 
message of a chart by applying inappropriate enhancements to the plot. Once the plot is 
in Excel you can use all Excel options to copy, save, and print the plot.  

Important: The Excel program continues to run unless you close it. If you want to save 
the graph (and data associated with the graph) select File/Save as in the Excel Program. 

Step 5: End the Excel program by selecting File/Exit to return to the main SDA data 
grid. 

Tutorial 5 – Opening an Excel data file 

SDA can open files in several common data formats including Microsoft Excel. The data 
to be imported must be in an acceptable format. For example, an Excel file in your SDA 
data directory named EXAMPLE.XLS contains the following information: 

 

Notice variable 
names in row 1. 
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Notice that this file includes variable names in the first row and that each column 
contains consistent data (text or numeric entries). A few guidelines for preparing your 
data in Excel for use in SDA are: 

• The first row of the Excel file should contain SDA compatible variables names 
(must start with an alpha character and contain no blanks).  

• Each column must contain consistent data values. For example, in an AGE 
column (which should be numeric) you should not include any non-numeric data 
such as >29 or NA. 

• Character codes such as M and F for male and female should be in consistent 
case. 

• Avoid blank cells in your data set. If you have missing values use a missing value 
code such as -9 for AGE (an impossible value).  

• Once you’ve imported your data set, be sure to define any missing value codes in 
SDA (Attributes tab) 

For a more detailed description of how to prepare your data file in Microsoft Excel, see 
Elliott et al (2006). (See references.) 

The following is an example of how to open an Excel file in SDA. You do not need to 
have Excel on your computer for this to work.  

Step 1: Select File/Open Dataset. 

Step 2: In the Open dialog box select File of Type and choose XLS – Excel 97 or 
newer.  

Step 3: An example file on disk that you can use for this example is named 
EXAMPLE.XLS. Select EXAMPLE.XLS and Open. You are asked if the first row 
contains variable names. Choose Yes. 

Step 4: The file is opened. It is a good idea to save the file in SDA format. Select 
File/Save as and choose Files of type SDA – and Save.  

Step 5: If needed, click on the Attributes tab and define any needed Missing values or 
adjust the names, types and widths of each variable.  

The data are now ready to use in an SDA analysis. 

 

Reference: Elliott AC, Hynan LS, Reisch JS, Smith JP. “Preparing Data for Analysis 
Using Microsoft Excel.” Journal of Investigative Medicine. Vol 54. No. 6, September 
2006. 


